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1. #§=E

TryBT 1% i0S 13.0 LAF#D iOS im R TEME L £9, FFfis-R— K & Bluetooth Low Energy 2 & %% & 7L
#®. GATTH—ERXRTT—A2RBET IV U ITILEEERRLET ., FLAT7TIVOY—XI— FIFHRETHE
KIOSA7OoY I rELTERMEINAET,

1.1 EEIRIR

TryBT OEMERERICHEHRN—FRI T 7!

e iOS iR i0S 13.0 LIRE

e  Macintosh PC

o  TEOWLWTIhADFEEAR— F
- Target Board for RX23W F7=[d Target Board for RX23W module **
- EK-RA4W1 #*2
- EB-RE01B *3

;¥1 Target Board for RX23W & & U Target Board for RX23W module [Z(& TryBT &@IERTEEL T 7 — L
DITHAHERBICEEAFTFATVET, 77—LAVIT7EBEEZZTATHEE. UTOVAM VIR
B—rAA4 FO518 THERY I bz 7~0ERT] 288BL, HEKI7—LI I 7E2EETRA
TLEEELY,

RX23W 4'JL— 7 Target Board for RX23W Y4 w9 R4 — kH A F (R200S0014)

S>mot 7+ JLAHD ble_demo_tbrx23w_profile_server_preinstall_yyyymmdd.mot 7 7 1 JL
RX23W %' JL— 7 Target Board for RX23W module ¥ 4 v 2 X2 — k H 4 F(R20QS0022)
S>mot 7 # /LA AD ble_demo_mtbrx23w_profile_server_preinstall_yyyymmdd.mot 7 7 1 JL

2  EK-RAAWL IZIE TryBT &BIERIBEL T 7 — LD T 7HAKFRICEEATATOES, 77—4LDz
TEHEEZTATHEEIE. UTOIVA4vI X2 — kA4 FD 6 E [Restoring Factory Settings] %
BEL, BEE I 7—LAYITFEEEATLEEL,

RA4W1 Group Evaluation Kit for RA4W1 EK-RA4W1 Quick Start Guide (R20QS0015)
bin.zip IZ& F N % Restore_Factory/r20gs0015.srec

3 EB-REOIB [(FHETEFIC T 7—LI T 7HEZTAFNTULER A, TryBT L BERIGELG I 7—LV T
TEEEATUHAIE. UTORF1AV D248 (D7—LDzT7EEAH] 2BBL. 77—
L)z T7E#EETAANTLIEEEL,

REO01B 4 JL— 7 Bluetooth Low Energy # > ZJLa— K (using CMSIS Driver Package) (ROLAN5606)
>ROM_Files 7 # LA A ble_project_server.hex

LI, AZE(FEEMAR— K& LT Target Board for RX23W B3 21580 FIEERHE L TLVES, EK-
RA4W1 F71-(3 EB-RE01B Z A9 555 L FIEIER LTI,
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BERERE A D i0S imK:
e iPhone SE % 2 t#fX (i0S 14.7)

TryBT QOEMEHERICHERY I b7
e MacOS 10.14.4 Mojave A&
e Xcode 11.0 L& (AFHEE 2.1 HiSR)

JOoozy bk

HEEEE: Swift (hitps://www.apple.com/jp/swift/)

TryBT
=

ERIER:

TryBT 7AY Y h% iOSIHEKITA VR b—)L L TENMEREER T B I(Z(E. Apple Developer Program D% #}
RBIZMATHIRENHYET,

https://developer.apple.com/jp/programs/
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1.2 FEFE
o AEME20214F9 A 30 ABATOMERRHERICE SV TERShFE L, AEHICEH I

EIRIT, MU FLEIE=ZBNERIT DIV I M Iz T7EIVY—ILDETON—U 3 VITRBT B E
ERITHILDOTIEHY TR A,

o AXREHICEHINEBFHRSEIVY 7 b7z 7OFAIZER L T Macintosh PC, i0S ifRICIEEHH

ELEBAETHYHEAR—UNERZAVFEA, XAERKED ITEEEE] 3 HHETIHREE
S,
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2. IRIBHEE

2.1 XCode DA VA +—JL
HERERBETHD Xcode 4 VR —ILLET,

1. AppStore ZEEL T, 7 TVEERT 4 —JL K T"Xcode"E AALFET,
2. AVRR—ILEERLET,

2.2 Homebrew A > RX —JL

Homebrew (& Mac OS IREBICHALESA TSIV EA VR =)L - EET BFE-0D/INvr—SI 12— % T
T, HRBEBED-OIZTF VXA F—ILLET,

1. EEEDURLIZZ7Z A LET, https://brew.sh/index_ja
2. HAEIZEHEINTWAL IR Y T ravT Yy KEOF7A a2 %EIRLT, a7y F"é:lE—L,iTo

v
i
Homebrew

mac0s (EelLinux) BT —Fvxr—Jyr—

Search Homebrew

1A=L

curl nttps://raw. gi thubusercortent . com/Homebresw instal 1/HEAD instal 1 . sh [

TS, ThERRT

2.1 Homebrew @4 > X k—)L(1)

3. Finder #i2&) L T[Applications]>[Utilities]IZ# &) L. Terminal ##&L 7,

Utilities

AirDrop 7 : >
pacents ks %5 adbd 3 ‘Eﬂ &g
Applications ]

Activity Monitor AirPort Utility Audio MIDI Setup Bluetooth File Boot Camp ColorSync Utility
Desktop Exchange Assistant

Documents 4
WARNIN "/ = m i
Downloads AY 7:36 N/ \Tg‘ 4%

Console Digital Color Disk Utility Grapher Keychain Access Migration
5 iCloud Drive Meter Assistant

) 7 >

Network
Screenshot Script Editor System Terminal VoiceOver Utility
Information

2.2 Homebrew @4 > X k—)L(2)

RO1AN6102JJ0100 Rev.1.00 Page 7 of 54


https://brew.sh/index_ja

Bluetooth Low Energy AR— b7+ VB9 TLT7 T r— a3y TryBT for iOS

4, FIg2 caE—LEavY Y RFEI—IFIILICBHYFITTEITLET,

$/bin/bash -c "$(curl -fsSL https://raw.githubusercontent.com/Homebrew/install/HEAD/install.sh)"
Checking for “sudo” access (which may request your password).

[Password:
This script will install:

/opt/homebrew/bin/brew

/opt/homebrew/share/doc/homebrew

/opt/homebrew/share/man/manl/brew.1
/opt/homebrew/share/zsh/site-functions/_brew
/opt/homebrew/etc/bash_completion.d/brew
/opt/homebrew

Press RETURN to continue or any other key to abort

2.3 Homebrew O A > X k—JL(3)

5. Terminal Thbrew E AAL Ttips ARFRENDZ EEHEELET,

$brew

Example usage:
brew search TEXT|/REGEX/
brew info [FORMULA|CASK...]
brew install FORMULA|CASK...
brew update
brew upgrade [FORMULA|CASK...]
brew uninstall FORMULA|CASK...
brew list [FORMULA|CASK...]

Troubleshooting:
brew config
brew doctor
brew install --verbose --debug FORMULA|CASK

Contributing:
brew create URL [--no-fetch]
brew edit [FORMULA|CASK...]

Further help:
brew commands
brew help [COMMAND]
man brew
https://docs.brew.sh

2.4 Homebrew @A > X b—)L(4)
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2.3 Ruby |&#FhRDA VX k—)L

Homebrew Z L T Ruby Z&#HICEFH L T, Xcode DS54 TS5 1) 2 &I % CocoaPods 4 VR b—

JILET,

1

2.
3.
4

Finder Z#2&) L T Applications— Utilities—Terminal Z#& L £,
ROAT REEFTLET, brew install ruby-build

ROAT2 FEEFTLET, brew install rbenv

PATH IZ Ruby DEREZEBMT 57z, UTDaAT Y FEERTLET,

cd

echo 'export PATH="$HOME/.rbenv/shims:$PATH"' >> .bash_profile
echo 'eval "$(rbenv init -)"' >> .bash_profile

source .bash_profile

$cd
$echo 'export PATH="$HOME/.rbenv/shims:$PATH"' >> .bash_profile

[$echo 'eval "$(rbenv init -)"' >> .bash_profile
[$source .bash_profile

st

2.5 Ruby DHE

XESETIEI z)LE L Thinbash ZERALTWET, TIAI M ILEEETT SFIBILLLTD URL &

ZHRLTSESL,

https://support.apple.com/guide/terminal/trmi113/mac

5. ruby -vZETLTruby D/N— 3 UM 222 URRICHE>TWDA I EF#HERLET, ruby D/A—2 3
UM222KFEDNHE. ULTOATY FTHRIDIDEA VA M—ILLA—SFILEZHESHLET
rbenv install -1 (A VA F—ILEBERRN—D 3 V—BEDXRT)
rbenv install x.x.x (FEELEZA—2D3 DA X =)L)
rbenv global x.x.x FHEELEN—23o~ADUIUVER)
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2.4 CocoaPods DA X k—)L

CocoaPods [ i0S 7 TUMAITHY—FIR—FT 1 54T #EBT H-HDY—ILTY, TryBT FADx
4 kX CocoaPods 2R LTSA4 ISV EEEBLTWET, FEED URLIZF Y AL CocoaPods &1 ~
A= LTLEELY,

https://quides.cocoapods.org/using/getting-started.html

25 TryBT 7Oz FDiEE
TryBT 7B 2 x4 k% Xcode TEEILFET,

AXEICHRFENE-TBT 7Oz bR zZip 77/ LEREALET,
BRLEZI7A LT EZEED I ILTICBELET,

—SFIILFEEFHLT, TyBT 7AD ) FERBEALLZIAILFITcd AT RTHEBLET,
RNOATY FEETLET, pod install
TryBT 7Rz MIERALTWASATZUMNERS VX F—ILENFET,

P owbdhpeE

pod install OV FOETTTERDIT—MHET LHHEEIE. Xcode A =2 —D
[Xcode]>[Preferences...]%&##R L. Location # 7T Command Line Tools ZE&E L TL 2Ly,

xcode-select: error: tool 'xcodebuild' requires Xcode, but active developer directory
'/Library/Developer/CommandLineTools' is a command Lline tools instance

Locations

Locations Custom Paths

Derived Data: ' Default

Advanced...

Archives: | Default

Command Line Tools: | Xcode 12.5.1 (12E507)
5]

2.6 Command Line Tools D& E

5. R—7# JLFMAIZ TryBT.xcworkspace BMER SN FE T, TryBT.xcworkspace 4 JI/LY ) v LTTA
Dy bERELET,

[Forward TryBT

Name

AirDrop Podiile

Recents B Podfile.lock
> @ Pods
> M TryBT

Applications

Desktop B TrvRT xeodenroi
Documents B TryBT.xcworkspace
> M IryBllests
> @ TryBTUITests

Downloads

27 TryBT 7OC x4 FDFEE

RO1AN6102JJ0100 Rev.1.00 Page 10 of 54
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2.6 Apple Developer 7 h o> FDERTE
IOS IHFKRIZ TryBT 4 VR b—)LT Bf=5HIZ1F. MAFEHD Apple Developer 7 h > k% XCode I125%
ETILENHYET,

1. Xcode M #* =1 —T[Xcode] >[Preferences|Z#R L FJ,
2. Accounts # JTETD+HR2 %9 1) w4 LT, Apple Developer 7hH > b#EMLET,

Accounts

@ AppleiD

Apple ID:

Description:

Download Manual Profiles Manage Certificates...

2.8 Apple Developer 7 717 > FDE&E (L)

Select the type of account you would like to add:
Apple ID
@8] Xcode Server

fJl Bitbucket Cloud

8l Bitbucket Server

Cancel Continue

2.9 Apple Developer 7 777 > F DERTE(2)
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# = - Sign in with your Apple ID.
/ @J Don't have an Apple ID? You can create one for free.

Apple ID:

Cancel

2.10 Apple Developer 7 h > L DERE(I)
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2.7 Certificate Signing Request M {ERk
iIOS fHERADA >~ R b—ILIZHEZ Certificate Signing Request 7 7 1 LZERLE T,
1. Finder ##2&) L T[Applications]>[Utilities][Z#E) L. Keychain Access Z#EEILET,

Utilities

- N B w ® 8 B

Applications

Activity Monitor AirPort Utility Audio MIDI Setup Bluetooth File Boot Camp ColorSync Utility
Desktop Exchange Assistant

Documents — =

WARNIN .
Downloads Ay 7 4 m

A 7:36 4 N il g

Console Digital Color Disk Utility Grapher Keychain Access Migration
- iCloud Drive Meter Assistant

068 - B

Network
Screenshot Script Editor Terminal VoiceOver Utility

Information

2.11 Certificate Signing Request M E (1)

2. Keychain Access M * = 21— b [Keychain Access]—>[Certificate Assistant]>[Request a Certificate
From a Certificate Authority]Z:&iR L £9

3. User Email Address 7 « —JL FIZ Apple Developer Program TfEf L TLY% Email 7 KL X, Common
Name 7« —JL FIZRARIZ5E&EH LET, "Save to disk"Z:&#IR L FF, Continue R22%0 1) vo LT
Certificate Signing Request Z{&F L EJ .

Certificate Assistant

Certificate Information

Enter information for the certificate you are requesting. Click
Continue to request a certificate from the CA.
User Email Address:

Common Name:

CA Email Address:

Request is: Emailed to the CA
® Saved to disk

Let me specify key pair information

Continue

2.12 Certificate Signing Request D EK(2)
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2.8 Developer Certificate D1Ep &AM VR b—)L

iIOS IHKIZ TryBT 4 VR b—ILT B1=OIZHE Developer A®D Certificate L TA > X k—JLL

F9,

1. Apple Developer IZH 4 4 > LT, &£ * = a1—®"Certificate ,IDs &Profiles"ZR#R L FI,

Apple Developer
https://developer.apple.com/jp/

& developer.apple.com

& Developer Account

Renesas Electronics Corporation

= Overview '

@® Membership

@ People

@ 7% K ) A
@ Certificates, IDs & }i : Lk
[
People Certificates, Identifiers &
Profiles

Profiles

4 App Store Connect

@  CloudkKit Console

K Code-Level Support

E Documentation

© Downloads

O Forums

(O Feedback Assistant

App Store Connect

2.13 Developer Certificate D {ERL(1)

2. K A= a—D[Certificates]Z#IR L T. Certificates #ED[+]/R2 U E#IRLFT,

& developer.apple.com

& Developer

Certificates, Identifiers & Profiles
Certificates Certificate

Identifiers

PLATFORM CREATED BY

Devices
Profiles
Keys

More

2.14 Developer Certificate DEf(2)

Q All Types

EXPIRATION

RO1AN6102JJ0100 Rev.1.00
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TryBT for iOS

3. "Apple Development"#EiR L T Continue "2 &7 ) v LET,

@& developer.apple.com

& Developer

< All Certificates

Software

Certificates, Identifiers & Profiles

Create a New Certificate

© Apple Development

Sign development versions of your iOS, macOS, tvOS, and watchOS apps. For use in Xcode 11 or later.

Apple Distribution

iOS App Development

Mac Development

Mac App Distribution

to the Mac App Store.

Mac Installer Distribution

Sign your apps for submission to the App Store or for Ad Hoc distribution. For use with Xcode 11 or later,
Sign development versions of your iOS app.
iOS Distribution (App Store and Ad Hoc)

Sign your iOS app for submission to the App Store or for Ad Hoc distribution.

Sign development versions of your Mac app.

This certificate is used to code sign your app and configure a Di Profile for

This certificate is used to sign your app's Installer Package for submission to the Mac App Store

e ———

2.15 Developer Certificate M {ER(3)

4. Choose File TYERFEH D Certificate Signing Request 4R L T Continue R2 > %5 v LET,

@ developer.apple.com

& Developer

< All Certificates

Learn more >

Upload a Certificate Signing Request
To manually generate a Certificate, you need a Certificate Signing Request (CSR) file from your Mac.

Certificates, Identifiers & Profiles

Create a New Certificate

Choose File

Copyright ® 2021 Apple Inc. All rights reserved. ~ Terms of Use  Privacy Policy

Back

|

e ————

2.16 Developer Certificate D ER(4)

RO1AN6102JJ0100 Rev.1.00
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5. Certificate NMERLENFE LT-. LD Download R4 > %% 1) w4 LT Certificate #4 o >0—KLZE
¥, 49> 00— K L1 = Certificate # Finder ETHX IO Y w2 LTA VA M—=ILLET,

& developer.apple.com

& Developer
Certificates, Identifiers & Profiles
< All Certificates
Download Your Certificate
Certificate Details
Certificate Name Certificate Type
Development
Expiration Date Created By
2022/10/05

2.17 Developer Certificate D {E R (5)
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2.9 TryBT F App ID DR
TryBT @ App ID ZELET ., AppID [XIOS 7 TV —> 3 ek T—ERETT,
1. &+ = a1—0[ldentifiers]Z3#iR L T. ldentifiers EDFUW[+]/RE VU &EEIRLET,

@ developer.apple.com

& Developer

Certificates, Identifiers & Profiles

Certificates Identifier Q AppIDs

Devices
Profiles
Keys

More

Copyright © 2021 Apple Inc. All rights reserved.  Terms of Use  Privacy Policy

S —————————————

2.18 TryBT F App ID DERL(L)

2. "App IDs"%:&IRL T Continue RZ > &2 v LET,

@ developer.apple.com

& Developer

Certificates, Identifiers & Profiles

< All Identifiers

Register a new ==
identifier -
© ApplDs

Register an App ID to enable your app, app extensions, or App Clip to access available services and identify
your app in a provisioning profile. You can enable app services when you create an App ID or modify these
settings later.

Services IDs
For each website that uses Sign in with Apple, register a services identifier (Services ID), configure your
domain and return URL, and create an associated private key.

Pass Type IDs

Register a pass type identifier (Pass Type ID) for each kind of pass you create (i.e. gift cards). Registering
your Pass Type IDs lets you generate Apple-issued certificates which are used to digitally sign and send
updates to your passes, and allow your passes to be recognized by Wallet

Website Push IDs

Register a Website Push Identifier (Website Push ID). Registering your Website Push IDs lets you generate
Apple-issued certificates which are used to digitally sign and send push notifications from your website to
mac0s.

iCloud Containers
Registering your iCloud Container lets you use the iCloud Storage APIs to enable your apps to store data and
documents in ICloud, keeping your apps up to date automatically.

App Groups

S —————————————

2.19 TryBT F App ID D1ERL(2)

R0O1AN6102JJ0100 Rev.1.00 Page 17 of 54
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TryBT for iOS

3.

"App"%:ERL T Continue REZ &V 1w I LET,

@ developer.apple.com

& Developer
Certificates, Identifiers & Profiles

< All Identifiers

Register a new
identifier

=\
@
-

App Clip

@
]
o
S
2
Ej
=
&

2.20 TryBT F App ID D1ERL(3)

4. App D Z/Em L £, Description [Z"TryBT Development"# A AL E 3, App ID Prefix (EZDEFEIZL
F9, Bundle ID [EE# FA AL D OFEF|IEIZHEIFT T TryBT"#AHNLET,

& developer.apple.com

& Developer

Certificates, Identifiers & Profiles

¢ All Identifiers

Register an App ID

i0S, macOs, tvOS, watchOS

Platform App ID Prefix
RM4ZZ9ZAD4 (Team ID)

T . W

o

I [ TryBT Development

You cannot use special characters such as @, &, *

Capabilities App Services

ENABLED NAME

®\ Access WiFi Information

App Attest

B8 App Groups

Apple Pay Payment Processing

] I I com.renesas.TryBT

2.21 TryBT F App ID D1ERL(4)
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5. EmE#%A% 0O—)LL T Push Notification #F v % L. Continue /RZ %0 ) v LET, HITT
Register R2 &2 1) v LET,

@ M < [ )] & developer.apple.com [ @t + O

< All Identifiers

Register an App ID
Personal VPN

] Push Notifications

® Sign In with Apple
@ SiriKit

System Extension

©

1 Time Sensitive Notifications
User Management
Wallet

Wireless Accessory Configuration

D0 @ ®

Mac Catalyst

Copyright © 2021 Apple Inc. All rights reserved.  Terms o fUse  Privacy Policy

e

2.22 TryBT F App ID DERL(5)

R0O1AN6102JJ0100 Rev.1.00 Page 19 of 54



Bluetooth Low Energy AR— b7+ VB9 TLT7 T r— a3y TryBT for iOS

2.10 iOS im0 UDID #EE2
TryBT #4 >R b—JLF % i0OS KD UDID #HRBLET .
1. iOS#fikx%E Mac L HIRIEHRLET,
2. Xcode M * = 2 —T[Window]->[Devices and Simulators] &R L £9
3. Devices TiOS iR Z#IR L E£J , Identifier 7 1 —JL FIZRR SN BEA IOS iH*D UDID T,

e iPhone

Devices  Simulators 10S 14.6 (18F72)

Model: iPhone SE -
Capacity: 53.11 GB (50.68 GB available) Take Screenshot
Serial Ny View Device Logs
Identifier 00008030-00 Open Console

O iPhone

2.23 iOS fm*Ax®D UDID #EER
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TryBT for iOS

2.11 iOS imER D&%

iOS #H>RM UDID % Apple Developer [Z&8LE T,
1. ZE*=1—T Devices Z:&#R L. Devices DFW[+]RE2 &2 ) vo LET,

& developer.apple.com

& Developer

Certificates
Identifiers
Profiles
Keys

More

Certificates, Identifiers & Profiles

Device

Q All Types

NAME IDENTIFIER TYPE

2.24

i0S Ik D&ER(1)

‘ Edit ]

2. Platform 7 4 —JL K T"iOS, tvOS, watchOS"#:&#R L £, Device Name 7 1 —JL FIZIET /N X &5
A B=HDEED LRI, Device ID(UDID) 7 « —JL RIZIXiOS ##K®D UDID # AA L EJ, Continue
REVED) VI L, BITTROR—IT Register RE &7 w9 LET,

& developer.apple.com

& Developer

< All Devices

Name your device and ey

Certificates, Identifiers & Profiles

Register a New Device

Register Devices
To

Register a Device

nter its Unique Device Identifier (UDID).

Register Multiple Devices

Upload a file containing the devices you wish to register. Please note that a maximum of
100 devices can be included in your file and it may take a few minutes to process.
Download sample files >

I [ios, os, watchos

> ‘ Device List

Choose File

I-ﬂﬂiiﬁﬁnﬁ

Device ID (UDID)

B 2.25

iOS ImAK D& §(2)

RO1AN6102JJ0100 Rev.1.00
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TryBT for iOS

2.12 TryBT F Profile M {ERX

Profile Z4ER L £ 3, Profile (7 71) ® ApplD % Device i E &5 —TEE TSI 7M1 ILTT,

1. E*=21—T Profiles &R L. Profiles #D&FW[+HRE2 2 E0 v LET,

& developer.apple.com

& Developer

Certificates, Identifiers & Profiles

Profile

NAME PLATFORM TYPE

Certificates
Identifiers
Devices
Keys

More

Copyright © 2021 Apple Inc. Al rights reserves

Q All Types ~ All Platforms

EXPIRATION

‘ Edit J

S ——————————————

2.26 TryBT F Profile ®{EAL(1)

2. "iOS App Development"#;&R L T Continue RZ2 &9 ) v LET,

& developer.apple.com

& Developer
Certificates, Identifiers & Profiles

< All Profiles

Register a New Provisioning Profile

Development

©  i0S App Development

Create a profile to install apps on test devices.

tvOS App Development

Create a profile to install apps on tvOS test devices.

macOS App Development

Create a profile to install apps on test devices.
Distribution

Ad Hoc

Create a distribution provisioning profile to install your app on a limited number of registered devices.

tvOS Ad Hoc

Create a distribution provisioning profile to install your app on a limited number of registered tvOS devices.

App Store

Create a distribution provisioning profile to submit your app to the App Store

tvOS App Store

Create a distribution provisioning profile to submit your tvOS the Aj ore,

B 2.27 TryBT A Profile ®YER(2)
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TryBT for iOS

3. TryBT @ App ID #$8E L T Continue R2 &9 v I LET,

@& developer.apple.com

& Developer
Certificates, Identifiers & Profiles

< All Profiles

Generate a Provisioning Profile

Select Type > Configure > Generate > Download

Select an App ID

App ID: 12 Apo IDs

TryBT Development (: com.renesas TryBT)

Copyright © 2021 Apple Inc. All rights reserved.  Terms of Use  Privacy Policy

If you plan to use services such as Game Center, In-App Purchase, and Push Notifications, or want a Bundle ID unique to a single app, use an explicit App ID. If you want to create one
provisioning profile for multiple apps or don't need a specific Bundle ID, select a wildcard App ID. Wildcard App IDs use an asterisk (*) as the last digit in the Bundile ID field.

e |
=]

e ————

2.28 TryBT H Profile ®{E%(3)

4. {ERK LTz Certificate 3 EEL X9,

@& developer.apple.com

& Developer
Certificates, Identifiers & Profiles

< All Profiles

Generate a Provisioning Profile

Select Type > Configure > Generate > Download

Select Certificates
Select the certificates you w

Copyright © 2021 Apple Inc. All rights reserved.  Terms of Use  Privacy Policy

e
=]

10f 6 item(s) selected

e ———

2.29 TryBT A Profile D {ERL(4)

R0O1AN6102JJ0100 Rev.1.00
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TryBT for iOS

5. iOS#HEK%EEIRL T Continue RZ &V vy LET,

& developer.apple.com

Certificates, Identifiers & Profiles

< All Profiles

Generate a Provisioning Profile

Select Type > Configure > Generate > Download

Select Devices
Sele ices

© Include Mac Devices

Select All

2.30 TryBT H Profile D {ER%(5)

‘ [ [} continue

5 of 48 item(s) selected

6. Profile Z&HANT 5-DDBMHEANLEFS ., CZTIEH'TryBT Profile"&E AALTLET, ARE,

Generate R2 &9 ) w9 LET,

@ developer.apple.com

& Developer
Certificates, Identifiers & Profiles

< All Profiles

Generate a Provisioning Profile

Select Type > Configure > Generate > Download

Review, Name and Generate.

The name you provide will be used to identify the profile in the portal

I TryBT Profile] ]I

Type
Development

App 1D

TryBT Development( com.renesas.TryBT)

Certificates
15elected

Devices
5 Selected

2.31 TryBT A Profile D {ERL(6)
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7. Download R&# > %% w5 LT Profile #4»>A—FKLET,

& developer.apple.com

& Developer
Certificates, Identifiers & Profiles

< All Profiles

Generate a Provisioning Profile Download

Download and Install

Download and double click the following file to install your Provisioning Profile

Name: TryBT Profile
Type: Development
App 1D .com.renesas.TryBT

Expires: 2022/10/05

2.32 TryBT H Profile D {ERL(7)
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2.13 TryBT 7B < =4 b~A® Profile O RBEESF 1+
Ay 0— K L1 Profile # TryBT 7O x4 MMZBEERTET,
Xcode TTryBT 7Yz FEERLET,
[TARGETS] T TryBT #3%iR L. "Signing & Capability"® 7 Z:&R L E£ I,
"Automatically manage signing"®F v 7 #54 L E T,
Bundle Identifier 7 £ —JL KIZ Apple Developer TAALT=AppID ZFAHLZET,

Provisioning Profile 7 4 —JL K% % 1) w4 L T"Import Profile"%®IiR L. 2. 128 A vO— KL=
Profile Z{8E L E¥J .

a > W N R

® il > ;!| TryBT ,\ iPhone Finished running TryBT on iPhone

HEZaASF EDBE 08 < [ TryBT.xcodeproj
TryBT
: B TrysT m BTy
> B Pods ) General Signing & Capabilities Resource Tags Info Build Settings Build Phases Build Rules
PROJECT [[13% Alll Debug Release
B TryeT

TARGETS

~ Signing

Automatically manage signing
ﬁ TryBT
I TryBTTests

Bl TryETUITest Team Renesas Electronics Corpoeration
Ty ests

Bundle Identifier. com.renesas.TryBT
Provisioning Profile | TryBT Profile

Signing Certificate Apple Development:

233 TryBT 7B Y k~® Profile ®BEES I+
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214 TryBT DA/ ILEA VR =L
Mac & iOS Sk F B #RiER L T, iIOSIHRIZTryBT 24 VX F—ILLET,
1. Xcode ##EILTTryBT 7Oy FEREEY,
2. ERAT5HEKE Mac ITEKELET,
3. ELLEHMAEFHEINDE Xcode LEICIFRENRTEINET,

[ ] m = TryBT ) iPhone Finished running TryBT on iPhone

M T Q 5 O E : [® TryBT.xcodeproj

> @ TryBT & TrysT

> B Pods General Signing & Capabilities Resource Tags Info Build Settings Build Phases Build Rules

PROJECT v Identity

B TrysT
TARGETS Display Name

/!| TryBT Bundle Identifier com.renesas.TryBT

M TryBTTests Version 1.0

2.34 iOS LA DHEHE(L)

XiOS IR DEHE. Xcode LEBDREAEHFINAELMEEIL. Xcode LEDIHRERRBAZEI v L
T. FaYFEH 1) R FDIOS Device]h 5 i0S iR EEIR L TL SN,

= My Mac (Designed for iPhone)

;" Any i0OS Device (arm64)

& iPad (8th generation)
& iPad Air (4th generation)
2.35 iOS AR D HEHE(2)

4. Xcode EEMDBEREUEV ) VYT DHE. TyBTDAUNRAIEA VA M—ILARBESNET,

[ ] m - TryBT ) iPhone Finished running TryBT on iPhone

() I Q > & )y E : [& TryBT.xcodeproj

> A TryBT ® TryBT

> B Pods General Signing & Capabilities Resource Tags Info Build Settings Build Phases Build Rules

PROJECT v Identity

B TrysT
TARGETS Display Name

Bundle Identifier com.renesas.TryBT

& TryBT
M TryBTTests Version 1.0

236 TryBT@a /A J)LEA VAR R—IL
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3. FHER—KRADIT7—LDITEERAH
FHiiAR— K & L T Target Board for RX23W AT 5B ZHBALET . TOMHOAR—FIZOVWTEFH1L1IE
THRASNTVD FXa AV rESBELTIESL,

Target Board for RX23W [Z1& TryBT L BIEARER 7 7 — LD T 7HAHFBICEZTAFATVET, AE
[% Target Board for RX23W [ 7 7 — L =z 7 +#BEEEFATLHBEDOFIEERLET,

1. UFOURLIZZZEALTLFEL, MyRenesas 7HH > hTAOST A ik, REZTHEIZRAET S &
Tzip 774N EFHOA—KRTEET,
https://www.renesas.com/document/scd/rx23w-group-target-board-rx23w-quick-start-quide-sample-code

2. FIE1THAYA—FRLEZp 7274 LERBREALTLEE L, EVNREAD I 7—LD T TIXTED
mot 774 LT,
J/mot/ble_demo_tbrx23w_profile_server_preinstall_20191009.mot

RR—U T, ELKEHD T 7—L™ 17 % Target Board for RX23W [CZ2Z AL FIEEZRLET .
Ff, 77 —LDITDEZAHZIZUTOY—ILE=FRALET,
Renesas Flash Programmer (Programming GUI)
https://www.renesas.com/software-tool/renesas-flash-programmer-programming-qui
3. 77—LH 7 NDEEAHFEIL Target Board for RX23W ) ESW 1-2 % ON IZZEE L T, PC & ECN1
AR A%EUSBT—JILTEHRELET.

3 ECBERS
- fc?fc,”%; ESW1

N & ST

[RI001-P01398
FCCID2AENDRI23INTBQS6
1C:20194-RX23WTBQS6
1 POWER©
°R2[0 o

g R32
L E D o[mm] (<xo
N N MR

31 Z77—LDzTEZAHED Target Board for RX23W D& TE

4. Renesas Flash Programmer #8& L T[Z 7ML FEFLVWTOD ) FEEKRZEIRLET,

[‘ Renesas Flash Programmer V2.08.01 (Z{ER) — b4

JrILEB

3.2 Target Board for RX23W "D 7 7 — L™ T 7EERAHA(1)

RO1AN6102JJ0100 Rev.1.00 Page 28 of 54
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Bluetooth Low Energy AR— b7+ VB9 TLT7 T r— a3y

TryBT for iOS

5. [HLWITRD Y FOERIFA T O TUT%H
43>y kA—5: RX200

JOoozy & EFEOTOC Y M

YERIE AT REEDIFFT
v—Ib: E2 emulator Lite
4272 7x—X: FINE

EIR: s L e

RELTCHERIRZ2EI )Y LET,

& L0 J0T7 o

Pk el
w907 F0-Z

0T bE:

|tb_rx2 R0

FERSIEFCE: C¥ble¥mark space
iBis
W)L E2 emulator Lite ~ | A AR21—A00 FINE >

UNEERDY. | &S gEnEiR BE (il

HE2(E).

FAT)LC)

3.3 Target Board for RX23W ~AD T 7 — L™ = 7T EERAH(2)

RO1AN6102JJ0100 Rev.1.00
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TryBT for iOS

6. "BUENEMLELE"ERTSANE, BREFETTY,

7. FlE2 TEBALEZIAINFHNADOTRI7— LI T EEE
mot/ble_demo_tbrx23w_profile_server_preinstall_20191009.mot

JAa5S L7 74

LT[RE—HFKRE2ZIV VI LET,

ﬁ Renesas Flash Programmer V2.08.01 [Z{ERR)

IJrAE  FIAAERED  ALTW

FRIE  ERE JOoMRE Jviaddialy BEERE 1°-97-F

Jo¥oh g
BRIEOFOI b
w8000

th_rx 23w rp)
R#200 Series

FOUILIPL

TFAFuE:

— x

UL ~

|C:¥b le¥ mat¥ble_demao_thrx 23w _profile_server_preinstal_ 20191009 mat

TR
I 2 FdEiAd o> AlTRA

CRG-32: 10C1F345

3.4 Target Board for RX23W ~MD 7 7 — L™ = 7EEA#(3)

8. "BUENHIMLELE"ERTEANE, 77 —LVITOEZFRAHIETTT,

9. PC H i Target Board for RX23W ZHE Y S LE T,

10. 7 7—L = 7 DETHIE Target Board for RX23W & ESW 1-2 Z OFF ICEE L T, PC & CN5 O %

DB %EUSBy—TJILTEHRLET,

35 77—LDzx 7%?15%0) Target Board for RX23W D& E
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TryBT for iOS

4. TryBT OEKIEE

FTfi-R— K & L T TargetBoard for RX23W % {E AT 54| %

41 TNARXA—EHMT

RALEY,

TIVEEHTEHETNARA—BEHANRRINET, ERAELTN\A R LERRRERRLET,
Target Board for RX23W [T /34 R —& & C'RBLE-DEV"'E RRENFE T, "RBLE-DEV':24 v TF 5

& . Target Board for RX23W & DG AL L., ERT/\1 AFHEEZRRALET,

"Filter"#:8IRIT B ETNARETAIILRY) VI TEET,

No SIM =

Filke NO FILTER

)

-52

9)

58

)

-62

)

-40

{no name)

(no name)

(no name)

(no name)

(no name)

RBLE-DEV

-76 (no nai

Sort

No SIM Z (-
O & :
.
Filte NO FILTER = Sort NO SORT
2 52 (nonamo) >
L 71 (wname) >
. 79 (noname) >
< 58 (noname) >
? 62 (no name) >
S 40 RBLEDEV >
. 76 (noname) >
= 73 (no name) >
v =3 Bs
41 TNARXA—EEMEQ)
@ NoSIM P )
] .
O & O & :
NO SORT Filte NO FILTER | Sort = NO SORT
> % 52 (noname) DISCONNECTED »
> Select filter type FD >
> No filter D >
RSS! > -30dbm
> e ED >
RSS! > -67dbm
>l = RSSI > -70dbm ED >
RSSI > -80dbm
bR | P ceeeernann JED D
> . 76 (noname) DISCONNECTED >
> o 73 (noname) DISCONNECTED

42 TNAX—EE

E(2)
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"Sont"FBIRTBDETNAADY— FEZFIEETEET,

No SIM 7
Filte NO FILTER
0,.",' -62  (no name)
. 71 (noname)
. 79 (noname)
= -58 (noname)
= 62 (noname)
? -40 RBLE-DEV

-76

(no name)

(no name)

Sort

O #

NO SORT

No SIM & C_
.
O #
.
Filte NO FILTER | Sort = NO SORT
@ 52 (noname) DISCONNECTED »
o 71 (noname) DISCONNECTED >
o Select sort order Fo >
> No sort ED >
Sort by RSSI(Descending)
- il
% 40 RBLE-DEV DISCONNECTED »
. 76 (noname) DISCONNECTED >
-73  (no name) DISCONNECTED »

43 TNA RX—EEE?3)

YO— KRRV ER Y TEBETNS RA—EEBH

No SIM =

Filte

%)

D)

49)

9)

%)

.3)

9)

9)

RSSI > -70

-43 RBLE-DEV

45 (no name)

49 {no name)

50  (no name)

-58  (no name)

-60  (no name)

-61  (no name)

67 (no name)

Sort

RAHTEET,

@)

cee \I

%

RSSI(DESC)

4.4 TINA XR—EEE4)
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RERE VEHS Y TF B E"Register UUID name" & "Bluetooth Settings"MEBR SN FE T,

"Register UUID name"##iRFH L. GATT JAT 7 ILDY—ERZEZTD UUID #&HTEET, &%
ESINT-H—ERZIFERT /N XFHEERD

1DDAHTY, TRFIEE 411 ZSB LTS,
Target Board for RX23W [CRE SN TWSH—ERLZRTTIBEIIUTONTIHIZEHELET,

00001800-0000-1000-8000-00805f9b34fb: GAP Service
00001801-0000-1000-8000-00805f9b34fb: GATT Service

58831926-5f05-4267-ab01-b4968e8efce0: LED Switch Service

No SIM =

Filte NO FILTER

52 (no name)

& =
-

L —J

- 8

L —

- 62

7

"Bluetooth Settings"#:#iR9 % & i0OS D Bluetooth

No SIM &

(no name)

{no name)

RBLE-DEV

(o name)

Filte NO FILTER

.,)

52 (no name)

)

4)

-6

-40

.3)

(no name)

{no name)

RBLE-DEV

(no name)

Sort

Sort

O

%

NO SORT

O

%

NO SORT

- NoSIMF

Filte NO FILTER

(no name)

RBLE-DEV

{no name,

(no name)

Sort

Setting

HHFHRTRRSINET, GERK

11—

X e

TEHZTES UUIDIE

2 @5_

NO SORT

DISCONNECTED »

DISCONNECTED >

DISCONNECTED >

DISCONNECTED >

DISCONNECTED >

I Register UUID name I

> s
y e
> a5
> 7
5 75
>
>
>

Bluetooth Settings

Cancel

Register UUID name

Na... led switch

UUID 58837f57-5f05-4267-ab01-b4968e8ef...

45 TNA X—EETE(S)

- NoSIMF
-
-
-

Filte NO FILTER

> 2
> e =
> 85
> 7
> 75
>

>

(no name})

RBLE-DEV

{no name,

(no name)

TryBT

B} — ==
REEEERRCEET,
(o) | No SIM T
Ll
O {O} 0 < Settings
Sort  NO SORT
ALLOW TRYBT TO ACCESS
B Bluetooth
DISCONNECTED >
Siri & Search
DISCONNECTED >
DISCONNECTED »
DISCONNECTED
DISCONNECTED 3
Setting

Register UUID name

I Bluetooth Settings I

Cancel

4.6 T4 R—EEES)

canceL
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42 BEBET/NA REHHEST
BT /\/ REME®EIL Target Board for RX23W & DIEHIREZRTLET,

"CONNECTED"[3#E#ih THB L %2R LET, "CONNECTED" 24 v T3 B LEHEZUMLET, RIS
"DISCONNECTED"[ZYIBIKEETH D Z & ERLE T, "DISCONNECTED" %42 v T3 5L BEHKLET,

No SIM 7 [ No SIM T

Gk O @B OO @

RBLE-DEV RBLE-DEV

< o>

CONNECTED

Select demo Select demo
© |l © |l
LED Lights Up Ramdom Number LED Lights Up Ramdom Number

47 BTN AFEMEEmEQ)

"LED Lights Up"/RA2 &4 v T§5E54 FTEEEEZRRTLET ., BEEELD Back RE > THEHKT/N
A4 REME@EICEY £,

No SIM = (= NoSIMF (-
w00 @
RBLE-DEV

/A
= /3

CONNECTED 100

[msecjc]

Select demo

LED Lights Up Ramdom Number @

4.8 T/ NA RFEHHETEQ)
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"Random Number'/R2 V&2 v 745 LT — 2 TEEEEZRTLET, BEEEAL®D Back K3 > TEHKT
NA REMEmEICEY E9,

No SIM = (= NoSIMF (-
< Back O ® & : :
RBLE-DEV
@ 72°c

o
< = -
ﬁli - 32°C
|

il
Select demo

50

sa0
50
W 00
w0
@ 30 30
I il
-— 20 20
LED Lights Up Ramdom Number o B . ;
||
W value

49 HEHET/NA RFEHETEQ)

YAa—RREUEASw T35 EHER LT- Target Board for RX23W DIEREFBHRAAATEET,

No SIM =

e [O]® & :

RBLE-DEV

"' -32

Select demo

@ |l

LED Lights Up Ramdom Number

X 4.10 T/ X EMAEE4)
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Info K% 2 ZBIRY % LA — FOFMBERERTLET,

No SIM =

< Back

L] No SIM = [—
O @ {é} S ¢ Back
RBLE-DEV RBLE-DEV
58831926-5F05-4267-AB01-B4968EBEFCEQ
led switch

Properties:Notify
5883C32F-5F05-4267-AB01-B4968E8EFCED
Properties:

¢

o -32

LED

Select demo

@ |uh

Lights Up Ramdom Number

411 BT/ NA RFEHEE(S)

HRERS U FH v TF B E"Bluetooth Settings"MERRENET,
"Bluetooth Settings"%#iR3 % & iOS O Bluetooth X EEE#RKLET,

No SIM =

£ Back

O @ |

RBLE-DEV

="

¥ -32

CONNECTED

(e No SIM T ==  NoSIM T
. .
g < Back O @ {§} 0 £ Settings TryBT
RBLE-DEV ALLOW TRYBT TO ACCESS

)
Bluetooth

| Siri & Search

S
=

CONNECTING
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43 4 FTEEE
54 b TEEETIL Target Board for RX23W M LED MR Z kT 2T EEERITTEET,
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INT—RE VT LED RiDFIE EBRZRELET,
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44 T—ATEEM@

T —4A TEEM®E TIE Target Board for RX23W ED R A v FE BT -UICEBERESETEREELTES
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5. Ty BTOHRZAIA X
AETETZIIVEA MLOTTYTALa0, RTSY V1 BERE. PAAVT

XE—KDE% -
BELIZIC

BIMEs

SETDAZEERLET, TWBTOVY I b Dz T7TREFHREATA XT BHEL,
fE SN TryBT 7O

T—ADNEEREENRETA
b/

s

VIO I‘@ﬁ*nﬁ%&bﬁr/n“ L—C < T’él‘\

51 Z77YBAMILOARBALTA R
A7 TUDEA FLEEETEET,

s

1. Xcode T TryBT ® 7O

ee @
B 2 Q

~ B TryBT

v i TryBT
B AppDelegate.swift
B SceneDelegate. swift
B ViewController.swift
B Main.storyboard
& Assets.xcassets
B LaunchScreen.storyboard
B Info.plist
B SplashViewController.swift
B BluetoothDetailviewController.swift
B Bluetoothinfo.swift
B TryBTUtlswift
B ConnectStatusview.swift
B LightsUpDemoViewController.swift
B RandomNumberViewController.swift
B ImageSelectViewController.swift
B versioninfoviewController.swift
B BluetoothDevicelnfoViewController...
B Configuration.swift
B RegisterUUIDViewController.swift

> @ TryBTTests

> @ TryBTUITests

> @ Products

> B Pods

+ (=) Filter

g

= TryBT )

PROJECT
B et
TARGETS
= TryBT
Ml TryBTTests
Bl TryBTU Tests

9 FERZTES, [Info]>[Bundle Name]T7 7Y B A MILEZEELET,

iPhone TryBT | Build TryBT: Succeeded | Toda

[ TryBT.xcodepro]

General  Signing & Capabilities  Resource Tags | Info Build Settings  Build Phases  Build Rules

~ Custom iOS Target Properties

Key Value
Bundle name $(PRODUC
Bundle identifier sirruL
6.0

YES

:
Launch screen interface file base name LaunchScreen
Executable file

Application requir

Dictianary
Boclean

$(PRODUCT_BUNDLE_PAC
$(DEVELOPMENT_LANG
(4 items})

1.0

Localization native development region
» Supported interface arientations (iPad)

Bundle version string (short)

DGO DO O

All Qutput &

X 51 Z7FYUEA RILOARZALTAR

52 7YV FA2A2DHAREIIAR
K7 TYDTFAAVELETETEET,

1. Xcode TTryBTO 7O
XETOBBEDT A2

v [& TryBT
~ i TryBT
B AppDelegate.swift
B SceneDelegate.swift
B ViewController.swift
B Miain etardhnard
Assets.xcassets
B LaunchScreen.storyboard
B Info.plist
B sSplashviewController.swift
B BluetoothDetailViewController....
B Bluetoothinfo_swift
B TryBTUtiLswift
B ConnectStatusView.swift
B LightsUpDemoViewController....
RandomNumberViewController...
B ImageSelectviewController.swift
+ [ (=) Filter

Gzzzzgzzggizgzzg

9 FEBREET, [Assets.xcassets]>[Applcon| TP A A VEERLET,

VEERBELTLSEEL,

& TryBT)  iPhone TryBT | Build TryBT: Succeeded | Today at 17:21

83 < Assets.xcassets

[& TryBT ) il TryBT ) i@ Assets.xcassets ) [E] Applcon
{: AccentColor
W antena_00
I antena_01
antena_02
2 antena_03

?
antena_04

P Anninnn 1 2x 3x
[E Appicon

a ol it

Bl arrow_up

btn_back
btn_close

btn_info

btn_menu
btn_reload
btn_setting
detail_bluetooth_list
M graph01_disabled
M graph01

Applcon

iPhone Notification iPhone
i0s7-14 Settings - i0S 7-14
20pt 29pt

- -
3x x
iPhone App

i0s 7-14
60pt

-

F-‘
2x
iPhone Spotlight

05 7-14
40pt

K52 Z7FUZ7A4a2DHAREIARX
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53 RTSYyYaBEEDARETAR
A7 TYRBBOR TS v 1 BEEERETEET,

1. Xcode TTryBTD7RAT Y FEREFET ., [Assests.xcassets | T"splash_background" & "splash_logo”
ZEBELFET,

] 2H] = TryBT)  iPhone TryBT | Build TryBT: Succeeded | Today at 17:21
52

I Q : (mNE BE < @ Assets.xcassets

« B BT [& TryBT ) i TryBT ) fi@ Assets.xcassets ) ] splash_background
¥ I 'conus

~ Il TryBT B iconos splash_background
AppDelegate.swift
B SceneDelegate.swift

B viewController.swift icon09
B i el Wl light_button_off

ht_button 2
Assets.xcassets x

B LaunchScreen.storyboard » Universal
B Info.plist y

B SplashViewController.swift L_FLECPTrS

B BluetoothDetailViewController.... B splash_background

B Bluetoothinfo.swift = spiast
+ [ (Z) Filter

X 5.3 RISy aBEEDHRAETA X(splash_background)

[ ] W] = TryBT}  iPhone TryBT | Build TryBT: Succeeded | Today at 17:21
ks

I Q > B < & Assets.xcassets

© [& TryBT [& TryBT ) @l TryBT ) @ Assets.xcassets ) Em splash_logo
| iconus

~ il TryBT B iconos splash_logo
B AppDelegate.swift B icono7
B SceneDelegate.swift H iconos
B ViewController.swift I iconog
B Main starvhnard Il light_button_off
ht_butt
Assets.xcassets [ iz
= progress_bar B
B LaunchScreen. storyboard Universal
B Info.plist
B SplashViewController.swift
B BluetoothDetailViewController.... =
B Bluetoothinfo.swift == splash_logo
+ | &) Filter ®

54 RTS5vaBENDANRZ A X(splash_logo)

54 FAAVT—EDAREIIAX
A CTEEALT A TEEEATHRIYA XARELGTAAVELEETEET,

XT7AAVIERKIBEETTY,
T4 aAvIEpng 74— b T200x200 DEBETHELTESL,
1. Xcode TTryBT 7O Y F#BEET, [Assests.xcassets]d icon01l~icon09 ZZELFT,

= TryBT}  iPhone TryBT | Build TryBT: Succeeded | Today at 17:21
BR < @ Assets.xcassets
v B TryBT [® TryBT ) il TryBT ) i@ Assets.xcassets ) [ icon01
~ M TryBT B icon_random =i
=

B AppDelegate.swift —
icon01

icon02
B ViewController.swift B icon03

B Main starvhnard B iconoa

B SceneDelegate.swift

Assets.xcassets B iconos 2x

B Launchscreen.storyooard B icon0s Universal
B info.plist

B SplashViewController.swift

B BluetoothDetailViewController....

B Bluetoothinfo.swift

B T DT i

+ (=) Filter

E 55 TEEHROD7Z7AIVT—EIDHREATAX

RO1AN6102JJ0100 Rev.1.00 Page 43 of 54



Bluetooth Low Energy AR— b7+ VB9 TLT7 T r— a3y TryBT for iOS

55 HARAIARXRE—FOEZE -
K7 TYFEARICTFAAVHELERTEDINARITARE— REHBEET,

1. Xcode TTryBTD 7RI xY FEFEET, Info.plist RD[AppConfig]>[IS_SHOW_ICON_WRITE]% 0
FrELIICEBELET,
1. hR22A4 XE—FEAEHIL
0: hRATA XE— FEEME

o Em] = TryBT)  iPhone TryBT | Build TryBT: Succeeded |
H Z C : ] B TryBT.xcodepro]

~ [ TryBT
v i TryBT General  Signing & Capabilities  Resource Tags. | Info | Build Settings  Build Phases  Build Rules
B AppDelegate.swift

B SceneDelegate.swift
B ViewController.swift B Tt Key Value
B Main.storyboard TARGETS Bundle name

Assets.xcassets M = TryBT Bundle identifier
InfaDictionary version

PROJECT ~ Custom iOS Target Properties

$(PRODUCT_NAME)
$(PRODUCT_BUNDLE_IDENTIFIER]
6.0

YES

:

LaunchScreen
$(EXECUTABLE_NAME)

LaunchScreen.storyboard M TryBTTests

B Info.plist Bl TryBTUITests
B SplashViewController.swift Launch screen interface file base name
B BluetoothDetailviewController.swift Executable file
B Bluetoothinfo.swift
B TryBTUtilswift
B ConnectStatusview.swift Dictionary
B LightsUpDemoViewController.swift S W Boolean
B RandomNumberViewController.swift
B ImageSelectViewController.swift
B versioninfoviewController.swift ment region
B BluetoothDevicelnfoViewController... > Supported interface orientations (iPad)
B Configuration.swift ©) Bundle version string (short)
B RegisterUUIDViewController.swift

> il TryBTTests

> M TryBTUITests

> @ Products

> B Pods

direct input events

€3 43 43 3 <> €> LD KD <> O <>

$(PRODUCT_BUNDLE_PAC!
$(DEVELOPMENT_LANGUA!
(4 items}

1.0

O OGO B D

All Qutput 3

B 56 HREIAXE—RDFUAT
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6. TryBTD 7T 74 LR
TryBT D7 7 A IVEREZRLET ., ARETIL. Info.plist.

swift 77 A ILIZDWWTHEHRLET,

TryBT/
| Podfile
|
—Pods/

AppDelegate.swift
BluetoothDetailViewController.swift
BluetoothDevicelnfoViewController.swift
BluetoothInfo.swift

Configuration.swift
ConnectStatusView.swift
ImageSelectViewController.swift

Info.plist

|

|

|

|

|

|

|

|

|  LightsUpDemoViewController.swift

| RandomNumberViewController.swift

|  RegisterUUIDViewController.swift

| SceneDelegate.swift

|  SplashViewController.swift

| TryBTULtil.swift

| VersionInfoViewController.swift

|  ViewController.swift

|

—Assets.xcassets

L—Base.lproj
LaunchScreen.storyboard

Main.storyboard

—TryBT.xcodeproj
F—TryBT.xcworkspace
F—TryBTTests
L—TryBTUITests

6.1 TryBT @ 7 # JLZHERK
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6.1 Info.plist [CDLNT

Info.plist (£ TryBT D7 T DEREFITSI1=HODT 74 ILTT, Infoplist 77 ALK, ZTUA VR =)L
BO7A a2 0NN—2ay, FIURTEERELEFT, FTHERTEEEFTRLET, FHEILKXYA +ETE
=& Ly, (https://developer.apple.com/documentation/bundleresources/information_property list)

i 6-1 Info.plist
R W=
Bundle version string (short) A7TVDN—2 3> (XFH) 2BELET,
51 : 1.0.0
Bundle version ELNFZBELBSTRELET,
Bundle name A7 TVDORTEBEEELET,
5 : TryBT

6.2 .swift

SWift DILEFDE T 7AILIE TryBT DEIE, OV Y I EHERTHI7MIVICHYEST, CCTREREDT7
AILOBEIZODVNTRELET,

T 6-2 sWiIftICEESIND T TADHE

Y5 R4 BE

AppDelegate TIV—2a & EKDSATHA IV EERTHY SR TY,
TryBT THEEHDERLGEBLITOTLET,

BluetoothDetailViewController Bluetooth FHflEImZ E& L T ET,

BluetoothDevicelnfoViewController | ###i L TW\ST/3f RDERERTT SEEEEEL TLET,

Bluetoothinfo Bluetooth — &7 DIEKEIFHREETRT SBERTT,

Configuration Info.plist Mo T—REWMBIT 5-6DI—TA VT4V FAT
ElR

ConnectStatusView CONNECTED & DISCONNECTED QR F#ENYEZZHRE L
Ea—Y35XTT,

ImageSelectViewController TAIVEBRTIEEZEELTLET,

LightsUpDemoViewController LED TEZTHOBEEZERZLTVET,

RandomNumberViewController T2 I7TEZASEEEERLTVLET,

RegisterUUIDViewController UUID B#FEEZEEL TWEY,

SplashViewController ATSYT 2 EETY,

TryBTUtil A—TFTA4VTARDAVY FEERT DY TATT,

VersionInfoViewController N—=2 3 VERZERTTHAIEEEZERZLTVET,

ViewController WEARTD Bluetooth —EEBE@EEE&EZ L TLET,
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7. TryBT OE@EER
TryBT DEEE Y SRABBEZUTICR&HLET .

pkg )
e O ® ' [
Register UUID name
: ViewController _I—) RegisterUUIDViewController
- UUIDE §%
T4 ZER
FRARA—EEHE .
UUDE A1 705
o OO & = -
RBLE-DEV
RBLE-DE
——— BluetoothDetailViewController BluetoothDevicelnfoViewController
< = —
TS RERRT
Select demo
i il
BTN AHAEE TR A REEE
T4 FTERR T—2TEER
< \ < i
LightsUpDemoViewController RandomNumberViewController
\17 v 7o
I: 32°C
!
54 FTFTEE@E F—4FEEA
7.1 TryBT DEmEE D 5 RER
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8. TryBT M Bluetooth i&{S

AETIL TryBT T® Bluetooth DERAAEICDONTHRER LET, iOS @ Bluetooth IZBE L TIEAK YA +
(https://developer.apple.com/documentation/corebluetooth) HE EHETTE L &Ly,

8.1 CentralManager [ZC& DA ¥ v U DET
CBCentralManager ¥ 5 X ##|A L T Peripherals 7/3f R & XF¥x ¥ LET,

viewDidLoad() {

.viewDidLoad()

centralManager = CBCentralManager(delegate: , queue: , options:

8.1 CBCentralManager D #]#i1t (ViewController.swift line 167)

startScan(){
print("begin to scan ...")

allBluetooth = Array<BluetoothInfo>()

centralManager.delegate =

centralManager.scanForPeripherals(withServices:

8.2 A ¥ > MEFT(ViewController.swift, line 208)

TNNAADAFT Y UHREZREBFLTRRAY R MIEHLED,
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centralManager(_ central: CBCentralManager,
didDiscover peripheral: CBPeripheral,
advertisementData: [String: Any],
rssi RSSI: NSNumber) {

print("pheripheral.name: String(describing: peripheral.name))")
print("advertisementData:¥(advertisementData)")
print("RSSI: RSSI)")

print("peripheral.identifier.uuidString: peripheral.identifier.uuidString)¥n")

bluetoothInfo =

BluetoothInfo(peripheral: peripheral, advertisementData: advertisementData, rssi: RSSI)

isAddBluetooth =
for addedBluethoothInfo in allBluetooth{
if(peripheral.identifier.uuidString == addedBluethoothInfo.peripheral.identifier.uuidString){
isAddBluetooth =

break

}
if(isAddBluetooth){
allBluetooth.append(bluetoothInfo)
.refreshTablle()

8.3 RF¥ ¥ UIERDRHF (ViewController.swift, line 313)

8.2 Peripheral 7/\1 AN

157 L 1= Peripheral 7734 R IZ##t L £9 . centralManager.connect D% —35|%(Z(X. CBPeripheral 7 5
RAEELET,

connect(){
.centralManager.delegate =
if( .peripheral != )
.centralManager.cancelPeripheralConnection( .peripherall)

.peripheral =

.centralManager.connect(bluetoothInfo!.peripheral, options:

statuslLabel.status = ConnectStatusView.ConnectStatus.disconnected

.lightsUpDemoButton.isEnabled

.randomNumberButton.isEnabled

8.4 Peripheral ~M#E#E (BluetoothDetailViewController.swift, line 168)
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BB OA XY X, centralManager @ didConnect 0 Delegate [S@&1 &N ET ., TryBT TlE., #E#ish
1= Peripheral T/3 1 R & REFELTWET,

centralManager(_ central: CBCentralManager, didConnect peripheral: CBPeripheral) {

print("didConnect")

statuslLabel.status = ConnectStatusView.ConnectStatus.connecting

UserDefaults.standard.set(peripheral.identifier.uuidString,

forKey: fromAppDelegate.LAST_CONNECTED_UUID)

peripheral.delegate =

.peripheral = peripheral

.lightsUpDemoButton.isEnabled

.randomNumberButton.isEnabled

8.5 E#i4 N> k (BluetoothDetailViewController.swift, line 229)

8.3 Service Discovery DEjf

TryBT Tl&. T/ 14 AFEMEBE D LED Lights Up"R4%2 > % L < [, "Random Number'7;R % > H 4%
TEndE. ZD Service D UUID #IEEL TH—ERBRRETVET,

lightsUpDemoPressed(_ sender: Any) {

if(peripheral != ){
selectedDemo = .lightsUpDem

UUID = CBUUID(string: fromAppDelegate.demo_uuid)

peripheral!.discoverServices([UUID])
}else{

.alertDisconectMessage()

8.6 Lights Up Demo M+ —E X#& % (BluetoothDetailViewController.swift, line 41)

Y—ERBRRDOETHER, ¥vIV2URTAvIERRLFET,

RO1AN6102JJ0100 Rev.1.00 Page 50 of 54



Bluetooth Low Energy AR— b7+ VB9 TLT7 T r— a3y TryBT for iOS

peripheral(_ peripheral: CBPeripheral, didDiscoverServices error: Error?) {
if (error = ) {
print("error: String(describing: error))")

return

service in peripheral.services!

switch selectedDemo{
case .lightsUpDem:
serviceUUIDArray =

NSArray(object: CBUUID(string: fromAppDelegate.LIGHT_UP_SERVICE_UUID))

peripheral.discoverCharacteristics(serviceUUIDArray as? [CBUUID], for:service as CBService)

case .randomNumber:
serviceUUIDArray =
NSArray(object: CBUUID(string: fromAppDelegate.RANDOM_NUMBER_SERVICE_UUID))

peripheral.discoverCharacteristics(serviceUUIDArray as? [CBUUID], for:service as CBService)

K 8.7 ¥v SV A2 RT 4 vYDIRE (BluetoothDetailViewController.swift, line 261)

FNSUVRURAT 4y REREREL, FEEICBBLET,
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peripheral(_ peripheral: CBPeripheral,

didDiscoverCharacteristicsFor service: CBService, error: Error?) {

if (error != ) {
print("error: String(describing: error))")
return

¥

if(service.characteristics!.isEmpty){

}else{

.characteristics = service.characteristics![0]

.characteristics?.uuid

switch selectedDemo{
case .lightsUpDem:

performSegue(withIdentifier: "tolLightsUpDemo",sender:
case .randomNumber:

performSegue(withIdentifier: "toRamdomNumber",sender:

88 F¥ TV ARANVRT 4 VY DRRERDELN (BluetoothDetailViewController.swift, line 283)

84 S4 FTEEE TCHDENDEZAH

4 FTEEETIE. R4 F—. TFRX I T4y FOEFERFIC peripheral ITEZEEAAFET, T—
REXNYSVRVRTa4vY., ETAAAEEERELFET,

writeValue(value:Int){
value:UInt = UInt(value)
data: NSData = NSData(bytes: &value, length: 1)

peripheral!.writeValue(data as Data,

for: .characteristics!,

type: .withResponse)

89 F¥ SV ARYRT 4 Y I~NDEZEAH (LightsUpDemoViewConroller.swift, line 142)

85 T—ATEEE TOEMFZIT

MEAR—FDRE I IARY FEZTMA-ODEMFZ(TEHRELET, Peripheral T/84 RIZ
LT, Notify DENENFHZRELET,
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viewDidLoad() {
.viewDidLoad()
menuBarButtonItem = UIBarButtonItem(

image: UIImage(named: "btn_menu")?.withRenderingMode(.alwaysOriginal),

style: .plain 5
target: B

action: #selector(menuButtonPressed))

navigationItem.rightBarButtonItems = [menuBarButtonItem]

peripheral?.delegate =

peripheral?.setNotifyValue( 8 .characteristics!)

8.10 Notify ®EF%h1t (RandomNumberViewController.swift, line 51)

SEEAR— KA S D Notify (£, LLT® didUpdateValueFor ) Delegate [Z@E1EhFE T,

peripheral(_ peripheral: CBPeripheral,

didUpdateValueFor characteristic: CBCharacteristic, error: Error?) {

if (error != ) {
print("Write...error: String(describing: error))")

return

newValuel = Int.random(in: 0...100)

newValue2 = Int.random(in: 0...100)

newGraphValue = Int.random(in: ©...100)
sampleData.append(Double(newGraphValue))
if(sampleData.count > 20){

sampleData.remove(at: 0)
¥
UserDefaults.standard.set(newValuel, forKey: fromAppDelegate.RANDOM_VALUE_1)
UserDefaults.standard.set(newValue2, forKey: fromAppDelegate.RANDOM VALUE_2)

UserDefaults.standard.set(sampleData, forKey: fromAppDelegate.RANDOM_GRAPH_VALUE)

refreshRandomValue()

8.11 Notify MER#F (RandomNumberViewController.swift, line 319)
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moEREDEEER

COTR, YA AVRREFITEAT S MEALOEEER] (COVTHALFT, BHOEREOZEEFEIIOVTE, REFa AV FEIUTY

ZHANTvIT—rESBLTIESL,

1. HESHE
CMOS HE DM Y L DBFHERFH L EDMAF TS, CMOS HARFBVHERICE > T — MERBIEEE LS EHHY FT . ERPR
FORRIZIE, HAAHFRSICERLTOIEERD FL—PIH OV r—2, BEROREH. ER7—RAGEEFAL, MALTIEICET—
REBLTLESV, FSRFYIREICKRBLEZY., WHFEM-o7Y LEVWTLESEL, Ffz. CMOS HEAERE L=AR— FIZTDWTHEHKDHK
WELTLESLY,

2. BREAROLE
BRIEARE. REOKEEFETY ., BREAKICIE. LSIONBEBORESFEETHY. LORIOREPLEHFOREFFETT . 5HB
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